
 
 
 
 
 
 
 

 
 

GNU Backgammon  



All About GNU 
 

by Albert Silver 
 
 

 By now, it’s fairly common knowledge that just about all the top players make use of 
the neural-net backgammon programs such as Snowie, or the older Jellyfish. The impact 
these programs have had on the way the game is understood and played cannot be 
overstated. Players of all levels have the option of purchasing these revolutionary ‘bots’ 
(short for robots) in order to not only have the pleasure of getting a drubbing by a world-class 
opponent as many times as they want, but also have it analyze their moves, games, and 
matches. The program will point out our mistakes, tell us how big a blunder our move was, 
and list the best moves. It is still up to us to understand why our move or cube action was 
wrong, however there is no question such a tool is priceless.  
 
 Perhaps ‘priceless’ is a poor choice of words as the price is by no means a given. 
Though the programs come with different options depending on how much one is willing to 
spend, a version with all the trimmings, such as importing one’s matches, analyzing the 
games, grading your play, allowing rollouts, etc. will set you back no less than $380 for 
Snowie or ‘only’ $220 for the older, and less sophisticated Jellyfish. This would seem to 
indicate that a top-quality aide is only in reach of someone with deep pockets or a deep 
commitment.  If not, one has to look at some of the free offerings available on the Internet. 
  
 That’s where GNU comes in. Personally, when I first heard of GNU Backgammon, I 
immediately remembered with a grimace my first experience with an old version of GNU 
Chess several years earlier: an engine that barely played at an expert level, as opposed to 
other master-level programs, an absolute bare minimum in functions, and graphics that 
reminded me of my first Atari video game system…. from back in 1977. The surprise that 
awaited me couldn’t have been greater. 
 
 GNU Backgammon is first of all a neural-net program of World-Class strength. It is 
based on the same technology from which Jellyfish and Snowie originated.  
 

Neural Net technology 
 

The concept of neural-net technology is what permitted the breakthrough in 
playing levels from ‘interesting amateur’ to ‘world-class’ playing literally on 
par with the best in the world. The person behind this brilliant idea is Gerald 
Tesauro, a researcher for IBM, who built the first neural-net program called 
TD-Gammon. The difference it brought was that instead of simply using 
weights and strategies of programmers and players, it created its own by 
playing against itself hundreds of thousands of times, with each version 
stronger than the previous one. By version 2.1, which had played 1.5 million 
games, two-time World Champion Bill Robertie declared it as good as a 
strong master and even wrote a book on the experience called “Learning 
from the Machine”. In fact, because of its independent learning, its play and 
that of subsequent programs using neural-net technology have revealed 
revolutionary strategic knowledge of the game from which top modern 
practice is based. GNU Backgammon is among those neural-net giants, 
and is among the top programs in the world. 

http://www.gnu.org/
http://researchweb.watson.ibm.com/massive/tdl.html


Features 
 
 How strong is GNU? 
 

On Gamesgrid, the famous online server where many of the world’s best play, a bot 
called GGRaccoon, using the GNU 0.13 engine and playing on a weaker setting so that it 
plays instantly, has achieved a rating as high as 2083 and is a favorite sparring partner of the 
top players there. 

 
A match was also done using Tony Lezard’s Dueller software where GNU 0.13 played 

100 7-point matches against Snowie 4 using their ideal settings. Although GNU won with a 
convincing 56-44, subsequent analysis, taking into account the luck factor, revealed that they 
were of exactly the same strength. The recently released GNU 0.14 is 1.18% stronger at 0-
ply (the setting of GGRaccoon) than GNU 0.13 at 0-ply. 

 
GNU is made of 3 neural nets: the contact net which is the main net for middlegame 

positions, the crashed net, and the race net which is so that GNU does not suffer from the 
common bane of backgammon programs: the non-contact bearin. For more information on 
how the neural nets were developed, see Joseph Heled’s (the developer) site The GNUbg 
Training Program. Be sure to select full instead of concise at the bottom left of the site if you 
do visit it. 

 
Brief feature list 

 
 Aside from offering an analytical engine of the highest order, GNU’s interface provides 
a very impressive number of features for users, many of which are not available in 
commercial programs. It’s worth mentioning that GNU Backgammon is also available for 
MacOS, Solaris, Linux, and other operating systems. There are also programs using the 
GNU engine running on Windows CE and the source is available to be ported to PDAs.  
 

• Import and export one’s games and matches from other sources such as FIBS, 
Gamesgrid (it imports comments as well), and TrueMoneyGames. 

• Analyze a game or entire match with a detailed report, including your rating and 
even the equivalent Snowie error rate. 

• Keeps track of your results in the Player Record 
• Rollouts galore with checker play according to score and extensive customizable 

options. 
• Setting up of positions. 
• Export to text documents (with diagrams) and PDF documents. 
• Export to HTML customizing the information exported and the graphics used. 
• Copy board and analysis to the Windows clipboard for easy pasting elsewhere. 
• Numerous ready-made board designs plus the option to make one’s own. 
• Several skins available. 
• Bearoff databases (both two-sided and one-sided), and tools to make ones own, 

however large (up to the 12-point, 13-point, etc.). 
 

Advanced players will also find a wealth of options to help in their study of the game:  
 

• Choose between any of seven Match Equity Tables such as Woolsey’s, Trice and 
Jacobs, or even the Snowie table. You can also create your own to use instead. 

http://www.gamesgrid.com/
http://www.jobstream.com/~tony/backgammon/
http://pages.quicksilver.net.nz/pepe/ngb/index.html
http://pages.quicksilver.net.nz/pepe/ngb/index.html
http://my.voyager.net/F7/80/rudnitsky/BGLightCE/
http://www.nongnu.org/bglight/


• A new Temperature Map to visualize the dangers and jokers of a move as well as 
the volatility of cube decisions. 

• Kleinman counts and Thorp counts. 
• Gammon Values and a powerful Market Value viewer showing the values of take 

points, cash point, beavers, etc. including separate values for a dead cube or live 
cube. 

 
What follows is a tutorial intended to present most of what GNU Backgammon has to 

offer, though not exhaustively so, and how to make the most of it. Therein you will find out 
about: 

 
Features 
 How strong is GNU? 
 Brief feature list 
Where to get it 
 Windows 95/98 users 
Playing a game 

  Players 
Reduced Evaluation (speed) 

 Move Filter 
 Playing options and Tutor 
 Backgammon variants 
  Nackgammon 
  Hypergammon 
 Starting a game 
 Human vs. human 
Advanced Playing Information 
 Match Equity Table 
 Kleinman and Thorp counts 
 Market Window/Gammon value 
 Temperature Map 
Importing and Exporting games 
 Importing games 

FIBS - Importing and analyzing 
GameGrid – Importing and analyzing 
TrueMoneyGames – Importing and analyzing 
Exporting games/positions 
Windows Clipboard export 

 PNG Image export 
 HTML export 
Analyzing matches 
Analysis Results and Grade 
Player Records 
Reviewing moves and mistakes 
 Windows layout 

Hint/Annotation window 
 Game Record 
Rollouts 
 Trials 



 Playing strength 
Evaluation for later plies 
Stop at specific Standard Deviation 
Truncated rollouts 
Cubeful 
Bearoff Truncation 
Variance reduction 
Quasi-Random dice 
Rollout as initial position 
Seed 
Same cube and checker settings 
Same settings for both players 
Final truncated evaluation 
My suggested settings 
Copy and Paste results 

Setting up a position 
 Names and score 
 Side, cube, and dice 
 Checker setup 
Appearance 

Skins 
Boards 

 Conclusion 
 A Word about ‘Cheating’  
 Acknowledgements 
 

Feel free to skip over parts that do not interest you or that you already know.  
 
 
  



Where to get it 
 
 The official site of GNU Backgammon is either http://www.gnu.org/software/gnubg/ or 
the new site at http://www.gnubg.org though you should be warned that this is not where you 
will want to get the program. To get the fully functional version you want to go to the site of 
one of the authors: GNU Backgammon for Windows. Go there and download the Installation 
Archive, a self-installing 12 MB file, and run it.  

 

 
 
Just so you know, there is a rather spooky warning below that says it is for people 

who “can live with software that suddenly crashes with no sort of warning (…) and like 
reporting bugs”. Frankly, it’s not nearly so dire, so don’t be put off by this. Of course if you do 
find a bug, or have a suggestion, do not hesitate to send it. 

 
Once you have done this, you will want to bring it up-to-date with the latest version, 

released very regularly, to enjoy the new features and bug corrections. For this, go to Nardy 
Pillard’s site This is not an 'official' GNU Backgammon page (for all practical purposes it is). 
There, scroll down to the part that says Latest Build and download the most recent file. The 
numbers aren’t some mysterious serial number but merely the date of the release. So Build 
030627 would just mean Build of 2003 June 27th. 

 

 
 
 Click on the link circled in red and download the file. Then install it and it will replace 
the old build with the new one in a simple step.  
  

http://www.gnu.org/software/gnubg/
http://www.gnubg.org/
http://home.online.no/~oeysteij/
http://users.skynet.be/bk228456/GNUBgW.htm


 If you are updating from an older build to the Installation Archive dated July 1st, 2003 
or later, it is suggested you uninstall the previous version first. Read below on how to 
preserve your settings and Player Records. 
  

Windows 95/98 users 
 
If you are using Windows 95 or Windows 98, you may experience problems and see 

GNU crash right from the start. If this happens, you most likely have an older build that had 
some compatibility problems. Go to the official site GNU Backgammon for Windows and 
download the Installation Archive which has fixes to the problem. It is suggested you uninstall 
the previous version before doing so, which brings another concern: how can you preserve 
your settings and Player Records?  

 
You’ll need to do copy a few files first. In Windows Explorer, go to the \gnubg 

directory, and then copy the files .gnubgautorc, .gnubgmenurc, and the subdirectory \.gnubg, 
and place them in another directory temporarily.  
 

 
 
Now uninstall your older GNU Backgammon, and then install the new build. After it is 

installed, go to the \gnubg directory and copy to it the files you saved. If it asks you 
permission to overwrite the files say yes. Now when you open GNU it will use your previous 
settings. 

 
 Playing a game 
 
 The first and most basic feature is to simply set up a game and play, so let’s start with 
that. Start the program and maximize the window. If the appearance isn’t to your liking, you 
will find out how to customize it further below.  
 
 Players 
 

First set the settings by clicking on the Settings menu at the top, then click on Players. 
This opens a window displaying the settings for GNU or allowing you to play against 
someone else (or even have GNU play against itself). At the top there is a tab where you can 
also set your name for the player. For the GNU engine, I prefer the pre-defined setting of 
Supremo for both checker play and cube decisions. At this setting it will take some time to 
play at given moments which may not be to the taste of everyone, so if you want a top-notch 
game, just a fraction worse, but almost instant, select Expert instead. You may also get tired 
of getting beat up by it (if you think it cheats, read the section A Word about ‘Cheating’), in 
which case, you can select more modest playing levels. 

http://users.skynet.be/bk228456/GNUBgW.htm
http://users.skynet.be/bk228456/GNUBgW.htm


 

 
 

If you are a Snowie user, or have seen Snowie’s analysis, you may wonder why my 
recommended level of play (Supremo) is set at 2-ply when Snowie’s strongest setting is at 3-
ply. The reason is simply one of nomenclature, or naming. Snowie starts counting at 1-ply 
whereas GNU starts at 0-ply, so GNU’s 2-ply is in fact the same search depth as Snowie’s 3-
ply. 

 
Reduced Evaluation (speed) 
 
This option is designed to increase the speed of play by taking a shortcut. Instead of 

averaging over all 21 possible dice rolls, it is possible to average over a reduced set, such as 
only 7 rolls which would be 1/3 or 33%. The 33% speed option should be approximately 3 
times faster than the full search with no reduction. One point, it has been noted that this can 
badly hurt GNU’s checker play so it is not advised to use it here. If you want it to play faster, 
and find Supremo too slow for example, set it at World Class, or try my Move Filter 
suggestion below. 
 
 Move Filter 
 
 The move filter allows you to control exactly how many moves GNU is examining at 
each ply. A ply is basically one move played by one side, thus if both sides played a move, it 
would be one whole move, but two plies, one for each side. To change the specific settings, 
press the Modify… button. 
 
 Although the level presets, such as World Class, Supremo, etc. are tested and good, 
you may want to know or control how GNU filters its moves to analyze and how many.  
 

 
 



 If you are playing Expert level (this is what GGRaccoon is set at) or another 0-ply 
setting, the Move Filter settings will not change a thing, as Expert level automatically 
examines all moves. At Supremo level, this changes though, as it takes a selection of the 
best moves from 0-ply and examines them at 2-ply. This means that for those selected 
moves it will calculate all the possibilities 2 plies ahead and evaluate them, allowing it to find 
better moves. Since Supremo is a 2-ply setting, we are only interested in the 2-ply settings of 
Large as in the figure above. 3-ply or 4-ply settings will have no effect here because 
Supremo doesn’t examine at that depth.  
 

In the figure above, we can see it first will Always accept 0 moves. This first line 
means that it won’t force any moves to be analyzed at 2-ply, it will only analyze moves 
according to the second line. If it had said it would always analyze 2 moves, this would mean 
that no matter how ridiculously bad the 2nd move was compared to the 1st, it would analyze 
both at 2-ply.  

 
The second line says it will Add extra 16 moves within 0.320. This means that 

provided they aren’t more than 0.320 equity worse than the top move, it will select a 
maximum of 16 moves to analyze at 2-ply. For example, in the diagram below 
 

 
 
 the 2nd best move is no less than 0.453 equity worse than the top choice, so it didn’t 
bother analyzing them at 2-ply as it is unlikely to change its mind on what the best move is.  
 
 Take a look at the figure below now: 
 

 
 
 Here, the exact same settings were maintained, but the 1-ply filter was activated. This 
just means that those 16 moves selected from the 0-ply are sent instead to be analyzed at 1-
ply, and then up to 5 moves from 1-ply will be sent to be analyzed at 2-ply. So this would 
actually be faster than the previous setting (and weaker), since a maximum of only 5 moves 
would be analyzed at 2-ply depth. 
 



*Tip* - Feel free to experiment with the settings, as you can always reset them by 
simply choosing one of the level presets. In order to see if they are better, or as good 
but faster, I’d suggest comparing the results with Supremo. One setting I have that 

works quite well, is to take the basic Supremo setting and in the Move filter reduce the 16 to 
12. It cuts down on the thinking time by 20-25% more or less, and I haven’t seen more than 
one case in over 10,000 moves where it missed the best move.  
 

Before going any further, do not forget to click on Save settings at the bottom of the 
Settings menu. You must do this every time you make changes you wish the program to 
remember the next time you load it. 
 
 Playing options and Tutor 
 
 In the Settings menu, select Options, and a small window opens. Here, you can 
activate automatic bear-off (it will automatically take off the most checkers if it can sparing 
you the effort of playing obvious moves), choose the equity table to be used (Woolsey’s, 
Snowie’s, etc.), select Nackgammon, choose to play with manual dice (you play with your 
own personal dice instead of the computer’s) AND a great teaching tool: the Tutor Mode. 
  
 When activated, the Tutor mode has GNU analyzing your moves and/or cube 
decisions and comparing them with its choices. You set the threshold for its alerts, so if you 
set it for bad, it will only warn you when you make a bad mistake. It will then allow you to re-
examine your choice, go right ahead with it, or provide a ‘hint’ essentially showing you its 
analysis.  
 

 
 

My personal choices are to set the limit to bad, and to set the Tutor decisions as 
Same as Analysis. 

 
*Tip* - Before going any further, do not forget to click on Save settings at the bottom 
of the Settings menu. You must do this every time you make changes you wish the 
program to remember the next time you load it. 

 
 Backgammon variations 
 
 Backgammon has a number of variations, some of which are quite popular on the 
servers. The main ones are Nackgammon and Hypergammon, both of which are supported 
by GNU, as well as an Eastern variation of the rules not allowing more than 5 checkers on a 
single point. GNU is also capable of directly importing and recognizing Nackgammon and 
Hypergammon games played on the servers for analysis. 



 
• Nackgammon – This variation of backgammon conceived by Nick “Nack” 

Ballard has two checkers removed from the 6 and 13 points and places them in 
the opponent’s board to form a second anchor. Play follows standard 
backgammon rules and games are naturally longer. It is considered a more 
strategical struggle, with luck influencing less, than normal backgammon. To 
play a game of Nackgammon against GNU, go to the Settings menu and then 
select Options. 

 

 
 

Under the tab Game, select Standard backgammon with Nackgammon starting 
position. This way it will set up a game of Nackgammon instead of normal 
backgammon. 

 
Hypergammon – Hypergammon is a very different game though it too follows 
the standard rules of backgammon. In it, each player starts with only 3 
checkers in the opponent’s board and must of course cross the board and bear 
them off as in normal backgammon. To play Hypergammon in GNU you must 
first build the Hypergammon databases using the tool makehyper.exe. The tool 
can be found at Nardy Pillard’s site This is not an 'official' GNU Backgammon 
page  

 

 
 

The bad news is that building the ~400 MB file for the 3-chequer database 
requires no less than 400 MB of Ram (less causes disk swapping and 
considerable slow-down) and should take days to build. The good news is that 
with the databases it will play perfect Hypergammon, the same as the bot on 
Gamesgrid called MrHyperbot. To run the tool you need to open an MS-DOS 
Prompt window from Windows 95/98/ME (Start  Programs  MS-DOS 
prompt) or a Command Prompt window from Windows NT/2000/XP (Start  All 
Programs  Accessories  Command Prompt). There follow the instructions 

http://users.skynet.be/bk228456/GNUBgW.htm
http://users.skynet.be/bk228456/GNUBgW.htm


in the diagram (or at the site) to build the databases. To start a game of 
Hypergammon go to the Settings menu and select Options. In the window that 
opens select 3-chequer Hypergammon, which will only be available if the 
databases are present. 

 

 
 

Starting a game 
 
To start a game, just click on the File menu, and choose New, and then your choice of 

a game, match, or money game session. When you are playing, it will automatically show the 
pip count (and difference), though you can de-activate it by going to Settings menu and in 
Appearance uncheck the box Show Pip count permanently.  

 
While playing, you can access the main functions through the toolbar at the top: 

 

 
 

The functions from left to right are: Rolling the dice, doubling, taking or passing a 
double (thumbs up, thumbs down), redoubling (beavering), telling the computer to play (if you 
just set up a position for example), edit the position (plus names and score), change the 
direction of the play, and stop the program if it is analyzing or doing a rollout.  
 

Mind you, you can roll the dice simply by clicking on the empty space of the board on 
the right side. Same goes for doubling, where you can just click on the cube on the board. 
 



 
 
After you’ve rolled the dice, just clicking on a checker will have GNU play the highest 

number with it, and after with a second checker or the same one, it will play the lower 
number. GNU will also help you see where the pieces can go. Just click on a piece and start 
to drag it. You will see the possible landing squares highlight in green. 
 

 
 
If you would like GNU’s analysis of a move or cube decision while playing, go to the 

Analyse menu and select Hint, or press the keyboard shortcut Ctrl-H. For details on the 
Hint/Annotation window, see below.  

 
Human vs. human 
 
You may wish to use GNU to keep track of a game or match against a friend, and play 

directly on GNU, or you may wish to enter a game from another source such as a book or a 
videotape for safekeeping and analysis. Here’s how to do it. 

 
1) First you must set both players to human, so go to the Settings menu and select 

Players… In the window that opens, select ‘Human’ for both players. You can also 
select the names here, but even if you don’t, you can change this later. 



 

 
 

2) Now go to the Settings menu and select Options… In the window that opens, 
select the Dice tab at the top and then choose Manual dice. This allows you to 
enter your own dice rolls. However, if you only want to play against a friend on 
GNU (so you can save and analyze), letting GNU roll the dice, ignore this step. 

 

 
 

3) Now go to the File menu, select New and start the game by selecting either match, 
or session (as in money game session). 

4) If you want to change the direction of the play (ex: left to right), just click on the 
Reverse Direction  button.  

5) You can set whose turn it is to play by clicking on the small chequer next to the 
player's name at the bottom.  

 

 
 

You can also set the turn of the player to move in the Game menu and by selecting 
Set turn at the bottom. 

6) To enter the moves, just play as you normally would against GNU: clicking on the 
board to roll the dice, selecting the dice rolled, and then playing the move. If you 
make a mistake in the dice rolled, just go to the Game menu again and select Set 
dice. 

7) If you make a mistake in the move played, and want to correct this, go to the 
Windows menu, and select Game Record. Use the Game Record to go to the 
move you want to correct, and just start entering a new move or dice roll from 
there. GNU will automatically continue the game with your change and erase the 
moves that came after. 

8) You can resign in the Game menu. 
9) Don’t forget to save your results regularly (File  Save) so you don’t lose 

important information by accident. 
 
 



Advanced Playing Information 
 
For players seeking more advanced information on the position, GNU also provides 

information on the Match Equity Table (MET), race theory (Kleinman count, Thorp count), a 
powerful Market Window/Gammon value viewer, and a new tool called the Temperature Map 
courtesy of Sho Sengoku. 

 
Match Equity Table 
 
The Match Equity Table can be viewed at any moment by entering the Analyse menu 

and selecting Match Equity Table. There you will see table values including Pre-Crawford 
and Post-Crawford scores. The table used by GNU is by no means imposed, and you can 
select any of a number of provided ones, including the Snowie MET, Woolsey’s, Jacob and 
Trice’s, etc. by selecting Load Table.  

 

 
 

In the window that opens, enter the /met directory on the left, and then on the right 
choose the table you want. The tables all end with the .XML extension, so to select the 
Jacobs and Trice table, choose jacobs.xml. Again, don’t forget to save the settings (Settings 
menu  Save Settings) otherwise it won’t remember your choice of table the next time you 
use GNU. 
 
 Kleinman and Thorp counts 

 
If the game situation is a race, one can look up what the Kleinman count or Thorp 

count has to say about it. 
 

http://www46.pair.com/sengoku/TempMap/English/TempMap.html


 
 
Market Window/Gammon value 
 
GNU offers a powerful Market Window/Gammon value tool to the advanced or 

aspiring player. This tool will answer all questions on a position’s take point, its double point, 
etc. for both players at any match situation, including side-by-side dead-cube/live-cube 
scores. If you wish to see how other match scores would affect the figures, you can simply 
use the arrows, and you can change the cube value. And if it is a money game, then the 
respective double, beaver, raccoon, redouble values will be shown instead. 

 

 
 



Temperature Map 
 
Sho Sengoku conceived and developed the idea of the Temperature Map, which is 

now available to GNU users. Essentially what it does is allow you to see the possible 
consequences of a move or cube decision in a visual manner. It is available in the Analyse 
menu, but you’ll most likely use it from the Hint/Annotation window. The best way to 
understand this is to give an example. Here is a move from a game against GNU where I 
made a mistake:  
 

 
 

As can be seen in the Annotation window below, GNU says my choice 6/3 lost 0.040 
equity and I should have played 24/22 6/5.  
 

 
 

I can of course conjecture the reasons or ask a master to explain this to me, but 
another choice is to see whether the Temperature Map can shed any light. To see it I 
highlight the moves I want to compare (it can be more than 2) and then press the Temp. Map 
button. Here is what it shows me: 
 

http://www46.pair.com/sengoku/TempMap/English/TempMap.html


 
 

The whiter the squares the worse the roll would be for me, and the darker the red, the 
better. I can see that after my play, a roll of 1 and 1, 3 and 1, or 4 and 4 for example, my 
equity would drop sharply, so it helps me see the dangers my play would allow. The 
Temperature Map is therefore ideal for “pay now, pay later” situations, and is also available 
for cube decisions. Why cube decisions you might ask? The reason is that it allows you to 
see the volatility of the position, and would thus allow you to see quickly and easily the 
potential market losers of a position. You can set the depth of the analysis as seen at the 
bottom of the figure above, but be warned that even a 2-ply analysis of all the possibilities 
can take some time. 
 
 

Importing and Exporting games 
 
GNU allows users to import matches from a variety of formats, including the Jellyfish 

formats, the FIBS oldmoves format, the Snowie GamesGrid format (.sgg), the 
TrueMoneyGames format (.tmg), and even Snowie’s Standard Text Format among others. It 
also allows you to export your games and positions into the Jellyfish format (.mat), HTML 
(including easily customizable graphics), a readable text format with diagrams (.txt), and 
even a PDF document. If you’d like to share a position and some analysis in text format, you 
can have GNU send this directly to the Windows clipboard for pasting. 

 
Importing games 
 
Since many players who play online will want to make use of this to analyze their 

matches, or at the very least see how they did, below are step-by-step instructions on how to 
do this whether you play at FIBS, GamesGrid, or TrueMoneyGames. Essentially, you just 
want to save the games in a format that GNU can read and then import them. 

 

http://www.fibs.com/
http://www.gamesgrid.com/
http://www.truemoneygames.com/


To import a match or position, just go to the File menu and choose Import. Then select 
the type of file you wish to import, find the file, and that’s that. 

 
*Tip* - For those who take online classes, please note that it imports the commentary 
saved on a move-by-move basis at GamesGrid, so you can see comments in the 
annotation window when going over the moves. I tested this with an online class and 

it was all there, neatly saved at every move. 
 

 
 

 FIBS - Importing and analyzing 
 
 These instructions are for use with JavaFIBS, my preferred FIBS client. 
 

1) After your match or game is finished, in the JavaFIBS client, go to the Tools menu 
and select Match Converter. 

2) In the window that opens, click on the match you want to analyze, and press the 
Convert button. I’d recommend deleting the match after this (pressing the Delete 
button) so the list doesn’t grow too big. 

 

 
 

3) Open GNU, enter the File menu, select Import, and then choose .mat match. 

http://www.fibs.com/~cthulhu/


4) Locate the match and import it. You’ll find it in the main JavaFIBS directory, in the 
subdirectory Match and then Jellyfish. See the *tip* below to avoid having to do 
this everytime. 

5) Go to the Analyse menu and select Analyse match. See Analyzing matches to 
learn how to change the analysis settings. 

 
GameGrid – Importing and analyzing 
 
1) When playing or watching a match at Gamesgrid, be certain to activate the Record 

button  so it will save the game when you are done. 
2) In the save game window, change the format to be saved to Gamesgrid Snowie 

Match (.sgg) and then press Save. 
 

 
 

3) Open GNU, enter the File menu, select Import, and then choose Gamesgrid .sgg 
match. 

4) Locate the match and import it. You’ll probably find it in the Gamesgrid directory in 
a subdirectory called SaveGame. See the *tip* below to avoid having to do this 
everytime. 

5) Go to the Analyse menu and select Analyse match. See Analyzing matches to 
learn how to change the analysis settings. 

 
TrueMoneyGames – Importing and Analyzing 
 
1) I’d first suggest changing the option in the TrueMoneyGames client so that it 

always saves matches by default. Note that you cannot save a match that you are 
only watching. After opening the program, go to the Tools menu and select 
Options. In the window that opens, click on the Table tab at the top and then set 
the options as in the figure below. 

 

 
 

2) After saving your game or match, open GNU, enter the File menu, select Import, 
and then choose TrueMoneyGames .tmg match. 

3) Locate the match and import it. You’ll probably find it in the TrueMoneyGames 
directory, called TMG, in a subdirectory called SavedGames. See the *tip* below 
to avoid having to do this everytime. 

4) Go to the Analyse menu and select Analyse match. See Analyzing matches to 
learn how to change the analysis settings.  

 



*Tip* - You can have GNU always remember where to get or save a specific file 
format. For example, to have it remember where to import your matches from 
Gamesgrid go to File, then Import, and then Gamesgrid .sgg match. In the window 

that opens, first go to the directory where the matches are saved, but before opening the file, 
press the Set As Default button at the top. After this, save your settings (Settings  Save 
Settings) and GNU will remember where to find your Gamesgrid matches. You can set GNU 
to remember different directories for each and every type of file format. 

 
Exporting games/positions 
 
GNU allows users to Export their games and matches into a variety of formats such as 

the Jellyfish formats, text format, not to mention PDF, LaTex, PostScript, and even HTML. 
Note that when exporting to these formats you get the moves, diagrams at each move, the 
analysis, and even the game/match statistics. In text format you’ll see the boards in ASCII 
art, and in PDF, you’ll literally get an instant e-book of the match. It also can export board 
positions and Gammonline HTML to the Windows clipboard for easy pasting. 

 
Windows Clipboard export 
 

• Text export - If you want to share a position and analysis with someone via e-mail or 
a bulletin board, you can save it to a text file and then recopy the contents, but there is 
a simpler way. When the position is on the board, go to the Edit menu and select 
Copy as and the Position as ASCII. 

 

 
 

Now all you need to do is paste it wherever you like using the Paste command from 
the menu or the Windows shortcut Ctrl-V (or Shift-Ins) and get something like this: 

 
GNU Backgammon  Position ID: sGfwGQDg28EBBg 
Match ID   : cAlvATAAIAAA 
+13-14-15-16-17-18------19-20-21-22-23-24-+     O: Kit Woolsey 
| X           O    |   | O  O  X          |     3 points 
| X           O    |   | O  O  X          | 
| X                |   | O                | 
|                  |   | O                | 
|                  |   |                  | 
|                  |BAR|                  |     11 point match (Cube: 1) 
| O                |   | X                | 
| O                |   | X                | 
| O           X    |   | X                | 
| O     O     X  X |   | X                |     Rolled 63 
| O     O     X  X |   | X                |     4 points 
+12-11-10--9--8--7-------6--5--4--3--2--1-+     X: Gammonline Readers 

 

If the diagram comes out bad, it is probably because of the font. To fix it to look 
like the above, highlight the text of the diagram and change the font to Courier New 
and the size to 9 or 10. 



 
To paste the analysis of the position, look at the analysis in either the 

Annotation window or the Hint window, highlight the moves, and press the Copy 
button. Then paste it just like the diagram. 

 
• Gammonline HTML export – If you are a GammonLine subscriber, enjoy the 

GammonLine BBS, and would like to share an interesting position, you can also make 
use of the GammonLine board images as seen in pretty much every article available, 
AND publish the analysis in elegant HTML. To do this go to the Edit menu, select 
Copy as, and then GammonLine (HTML).  

 

 
 

Now go to the text body in the forum and paste it with Ctrl-V (or Shift-Ins). This will 
work even if the analysis is only in the Hint window. 

  
PNG Image export 
 
You may also wish to simply save the board position as an image file that you can add 

to a Word document or HTML document for example. To do so, go to the File menu and 
select Export, then Position, and PNG. Be careful to add .PNG to the name when saving the 
image. The board image saved will use the color scheme currently being used. If you wish a 
different color scheme, change the design (for more info see Appearance|boards). You can 
also change the size of the image that is created by entering the Settings menu, then Export, 
and at the bottom right of the window that opens, set the size you want. 

 
HTML export 
 
GNU is capable of creating elegant HTML files so that you can publish your games on 

the web. It will create them exactly according to your specifications, including the number of 
moves, what it analyzed, the board design of your choice, and even the match/game 
statistics. Here is a sample of what it looks like: 

http://www.gammonline.com/


Move number 3: mamabear to play 31 

 

Position ID: 0HPhATDg2+ABMA Match ID: MIHlAEAAAAAA 
Pip counts: mamabear 160, KitWoolsey 162 

*mamabear moves 24/20* 

# Ply Move Equity 
* 1 2 24/20* +0.206 

  60.6% 21.1% 1.7% - 39.4% 8.9% 0.2% 
 2 2 8/5 6/5 -0.067 ( -0.272)

  55.2% 18.1% 1.1% - 44.8% 13.8% 0.6% 
 3 0 24/23 13/10 -0.244 ( -0.449)

  50.2% 15.1% 0.9% - 49.8% 15.1% 0.6% 
 4 0 24/23 24/21 -0.256 ( -0.462)

  49.8% 13.6% 0.8% - 50.2% 14.8% 0.4% 
 5 0 24/21 6/5 -0.285 ( -0.491)

  49.7% 14.4% 1.0% - 50.3% 16.5% 0.7% 
  
To set all the settings as you’d like, you need to go to the Settings and then select 

Export. There you can choose, down to the smallest details, what it will display and how. The 
‘how’ concerns the images used to produce board positions. This is chosen at the bottom of 
the window and you can choose between its own HTML images or two others, which are 
FIBS and BBS.  

 
You can choose what the board in the HTML page will look like, and have it appear 

exactly as the board design (see Boards for more on this) you are using in GNU. To do so, 
you need to create a directory to place the images and then export them. First, go to the File 
menu, select Export, and then HTML Images… Find a directory to place them in, or create 
your own by pressing the Create Directory button at the top. I’d suggest using the default 
name \html-images. Now enter the directory and press the OK button. Be careful to 
remember the name of the directory you placed the images in, including capital letters if you 



used any. Now go to the Settings menu, select Export and then at the bottom select GNU 
Backgammon board images (circled in red below) and type the name of the directory.  
 

 
 

 
*Tip* - If you want to post a position in an online forum that supports HTML you can 
do this regardless of whether the forum itself supports the necessary images. Here’s 
how: 
 
1) First be sure the image to be exported is currently on the board, and then in the 

Export settings set the HTML board type to fibs2html. In the space below URL to pictures, 
enter http://fibs2html.sourceforge.net/images/ as shown below. Be sure to click Ok, and then 
Save Settings. 

 

 
 

2) Go to the File menu, and select Export, then Position, and then HTML.. Save the 
file and then open it in Internet Explorer. In case this already sounds a bit mysterious, inside 
IE just go to File  Open  and click on Browse… Locate the HTML file you saved and 
open it. 

3) Once you see the board and image in front of you, still in IE, go to the View menu 
and select Source… This will open a small window with a lot of code. Copy the entire 
contents to the body of the post you are writing, and the board and analysis should appear in 
the forum without any problems. 
 
 

Analyzing matches 
 
GNU also comes with a set of functions that allow it to analyze a game or match, 

provide a detailed graded report, and allow you to navigate through the moves to quickly see 
the mistakes made. 

 
Before starting, you’ll want to configure the settings first, though this will only need to 

be done once. Go to Settings and select Analysis. A fairly large window will open, allowing 
you to play with as many settings as you could want. This is also where you set the 
thresholds for the Tutor mode (dubious, bad, etc.). Feel free to look around, but I simply set 
this to analyze checker play, cube decisions, and luck, and set the level of analysis at 
Supremo for both checker play and cube decisions. The Move limit setting is to set the 
maximum number of moves it will display in the Hint/Annotation window. 

 

http://fibs2html.sourceforge.net/images/


 
 
*Tip* - Once more, please do not forget to save (Settings|Save settings) after making 
changes in the settings, or you will be forced to change them again the next time you 
start the program. 
 
If you just played a match at an online server, import it first, then go to the Analyse 

menu and select Analyse match, or Analyse Session (money game session). If you only want 
to analyze a specific game, open it and then select Analyse game. Once started, you will see 
a bar in the bottom right corner showing the progress made in both the number of moves and 
percentage completed. 

 
 
Analysis Results and Grade 
 
Once GNU has finished analyzing your games, you’ll want to see the report and then 

go over the bloopers. In the Analyse menu, select Match statistics, and a window will open. 
Feel free to resize it (clicking and dragging the edges) to show more information. It will show 
you the results of both players side by side, allowing you to quickly compare notes.  

 

 
 



In the screenshot above you can see how it appears. It will detail bad moves (and 
good ones), not to mention rolls of varying luck, and attribute individual grades for your 
checker play, your cube decisions, your overall playing, and even your luck. It is very 
revealing when you see a very different evaluation of your checker play as opposed to your 
cube decisions. Another feature (in my opinion) is that GNU only grades your checker play 
according to non-forced moves, contrary to Snowie which grades while including moves that 
were spent on the bar or that were forced. In other words, if you played 50 moves but 10 of 
those were spent on the bar (you can hardly make a mistake if you can’t play), then GNU will 
average your error rate according to the 40 unforced moves. You can save these results with 
the match (File  Save  Match), so that you can see the analysis at anytime without 
having to redo it. If you are used to Snowie’s grade system, or would like to compare them, 
you will see the equivalent Snowie grade at the bottom. 

 
GNU can be quite tough on the grades, much harder than Snowie 4, so an Advanced 

grade in GNU could easily be an Expert grade in Snowie 4. Below are the limits of each 
grade: 
 
Snowie's thresholds (to understand the Snowie rating) are: 
 

0.0  -  1.2 : Extra-terrestrial 
1.2  -  4.4 : World class 
4.4  -  5.9 : Expert 
5.9  -  8.8 : Advanced 
8.8  - 12.6 : Intermediate 
12.6 -18.5 : Beginner 
18.5 - ?? : Novice 

 
GNU’s thresholds are: 

0.0000 - 0.0017 Supernatural 
0.0017 - 0.0062 World Class     
0.0062 - 0.0083 Expert          
0.0083 - 0.012 Advanced        
0.012   - 0.018 Intermediate    
0.018   - 0.026 Casual Player   
0.026   - 0.035 Beginner         
0.035   - oo  Awful!            

 
 GNU will also attribute an estimated Elo rating of your play based on the FIBS rating 
system, but it will only do so for match play. 

 
You can also copy the results of the report to another document. To do this, click on 

the lines you want to highlight using standard Windows functions (with the Ctrl and Shift 
keys), and then press the Copy button. Now open a document and paste (Ctrl-V) the 
contents of the clipboard.  

 
*Tip* - If you use a program such as Word or WordPad (avoid Notepad), the 
formatting will be lost when you paste it, but this is easily fixed: in the document, 
highlight the text, and change the font to Courier New and size to either 9 or 10. Ex: 



                                      Tami                 KitWoolsey           
Error rate (total)                    -0.205 (-3.770%)     -0.147 (-2.810%)     
Error rate (pr. move)                 -0.006 (-0.114%)     -0.004 (-0.074%)     
Checker play rating                   World class          Supernatural         
Rolls marked very lucky               0                    0                    
Rolls marked lucky                    1                    7                    
Rolls unmarked                        40                   34                   
Rolls marked unlucky                  0                    0                    
Rolls marked very unlucky             0                    0                    
Luck rate (total)                     +0.420 (+7.317%)     +2.497 (+45.772%)    
Luck rate (pr. move)                  +0.012 (+0.203%)     +0.061 (+1.116%)     
Luck rating                           None                 Go to Las Vegas imme 

 
Player Records 
 
You can keep track of the results obtained by yourself and your opponents using the 

Player Records. There you can store the statistics of your matches and keep records of the 
average results obtained such as checker play, cube decisions, and luck. It will also break 
down the results according to the last 20 games played, the last 100, etc. 
 

 
 
To add results to an existing account, or simply create a new account in which to add 

the results (of course you must first have an analyzed match open), go to the Analyse menu, 
and select Add to Player Records and Match statistics. If the account doesn’t already exist, 
GNU will create it automatically and add the results. If you wish to remove an account, then 
click on the name in the Player Records, and press the Erase button. 

 
Reviewing moves and mistakes 
 
Once you have seen the results of the report, you will probably want to go over the 

mistakes you made. To do this, you’ll need to open two more windows: Go to the Windows 
menu and select Game Record, and again to open the Annotation window. Two more 
windows appear, one showing the list of moves, and the other the analysis. However, the 
first issue that most likely needs to be resolved is one of organizing them so as to be a 
practical study tool. 

 
Windows layout 
 
When playing, it is normal to prefer the largest board display possible, however, when 

reviewing moves this is not possible. The following layout is what I recommend for screen 
resolutions of 1024 x 768, and 800 x 600. It is possible to shrink the board of course to easier 
fit the information windows but reviewing full matches then becomes tiresome in my 
experience. Feel free to create your own of course. 

 
First size the board to about half the screen width and drag the ends down so as to 

get a compact fit. If you are using an 800x600 resolution then I recommend using the 



smallest board size possible. Note that a bit of overlapping is inevitable. Here is an example 
of what it should look like: 
 

 
 
Game Record 
 
When opening the Game Record a small window will appear looking like this: 
 

 
 

It always opens to the last move of the last game You first have to click on a move in 
the notation before using the arrows. When you see a move highlighted, as seen above, you 
can navigate backwards and forwards move-by-move with the green arrows, and game-by-
game with the red arrows. If you use the buttons with the question marks on the green 



arrows, it will go from mistake-to-mistake. In the example used, GNU disagreed with one 
move by Kit Woolsey. The move in question wasn’t considered a bad mistake, but it did get 
earmarked as dubious. GNU adds these punctuation marks (standard in chess commentary) 
in order to identify how it evaluates a move. For example, a ‘?!’ indicates a dubious move, a 
‘?’ indicates a bad move, and a ‘??’ indicates a real blunder. 
 

Hint/Annotation window 
 

In order to see GNU’s analysis, go to the Windows menu, and click on Annotation. 
This is essentially exactly the same as the Hint window, except that the latter won’t include a 
space to add written notes. You will see a window open showing the best to worst moves 
from top to bottom. A first suggestion is to go to the Settings menu, then Appearance, and in 
it, to the right, make sure the box for GWC as Percentage is checked. Here is what it shows 
for the dubious move shown above: 

 

 
 
First of all, if you are new to backgammon software, and the above looks hopelessly 

complicated, relax, it isn’t nearly that bad. Let’s look at the 3rd line in red, the move that was 
played, and figure out what it all means: 

 
• Rank – As it’s ranked 3rd we know that GNU thinks it is only the 3rd best move. 
• Type – It says Cubeful which means that it is taking into account the possibility that 

someone may double. This means that occasionally you may see several moves with 
an equity of -1.000 (see Equity below), despite significantly different winning 
percentiles, because it thinks that if they are played then the opponent will double, and 
you should pass. The 2-ply is the depth GNU analyzed the move. 

• Win - This number is the percentage the move has to win the game. Thus the side to 
play has a 57.3% chance to win (including gammons and backgammons).  

• W g - This number is the percentage of wins that should end in gammons (including 
backgammons). Thus 27.1% of those 57.3% above will give you a gammon. 

• W bg – This number is the percentage of wins that should end in backgammons. Thus 
0.8% of those 57.3% above will give you a backgammon. 



• Lose – This is the percentage of losses expected. Thus one has a 42.7% chance of 
losing the game (including gammons and backgammons).  

• L g - This number is the percentage of losses that should end in gammons (including 
backgammons). Thus 8.1% of those 42.7% above will end in a gammon. 

• L bg - This number is the percentage of losses that should end in backgammons. 
Thus 0.2% of those 42.7% above will end in a backgammon. 

• Equity – This is the overall evaluation of the position by the program, after 
considering the different win/loss precentiles, the cube position, and the match score. 
A 1.000 would mean that you are expected to win a point, a 0.000 would mean that it 
is roughly equal, and a -1.000 that you are expected to lose a point. The score shows 
an edge for the side that played as it says 0.137 

• Diff. – This is the size of the error (the difference in equity) perceived in comparison to 
the top move. As we can see, the top move’s equity reads 0.187 and the move played 
only 0.137, thus equating to a -0.050 error. The thresholds of the degrees of errors are 
determined in the Analysis settings.  

• Move – This is the move being evaluated. In the case of the red line, it is the move 
that was played. 
 
As you can see, it shows the best moves considered, with the move actually played in 

red, plus the various equity scores for gammons, etc. Most players will focus on the last 
three, which are the total equity of the move, the difference in equity between the move 
played and GNU’s top choice, and what move is being evaluated.  

 
In the diagram above, we can see that at 2 plies GNU considers that 13/10* 7/1* was 

best, with 24/15 close behind. If you’d like to copy this information to a document, click on the 
moves that interest you in order to highlight them as above, and press Copy. Then paste it 
where you wish. Don’t forget to change the font to Courier New size 9 or 10 if you wish to 
maintain the formatting. 

 
If you’d like to see how the different moves it analyzed appear on the board, press the 

Show button.  
 

 
 

Now just click on the move you want to see and the board will display it. To see 
another move, just click on it. To exit Show mode to be able to analyze the moves or run 
rollouts, click on the Show button again. 
 
 You’ll also note a button called the Temp. Map . This is a powerful tool 
conceived and developed by Sho Sengoku. Please refer to the Temperature Map section for 
details. 
 

You may also want to have GNU analyze a few select moves a bit deeper. To do this 
you can have it go a 3rd ply, or do a rollout. Let’s have it do a 3-ply analysis of the three 
moves highlighted above. Just click on the number ‘3’ and it will do a 3-ply analysis. Be a 
little patient as 3 plies is considerably slower than 2 plies, but it shouldn’t be too long. If you 
want to customize the evaluator, click on the button indicated with a small red circle , 



and change the parameters you want. Now just click on the Eval button, and let it compute its 
results. You may also prefer to see the Match Winning Chances of the moves instead of the 
equity. This shows the chances of winning the match as opposed to the evaluation according 
to a single game. To do so, press the MWC button: 

 

 
 

Here we see the results of the 3-ply analysis, displayed in percentiles. We can also 
see that GNU now clearly favors 24/15 after deeper analysis. How about a rollout? 

 
 
Rollouts 
 
So what’s a rollout? A rollout is when you have the program play against itself a set 

amount of times (number of trials) and then sum up all the results of wins, losses, gammons, 
etc. from those games to give a more precise evaluation of a move/position. The interest is 
that the program may easily be underestimating some features/dangers of a position, and not 
realize this by only looking a couple of plies ahead. By playing it out, things will happen, and 
the game will unfold, giving it more accurate information on the consequences of a move. 
One can do a full rollout, meaning it will play the position out until the last checker is born off, 
or it can be a truncated rollout, playing to a certain depth in plies, enough to evaluate the 
consequences.  

 
Rollouts can be done at any time either directly from the Analyse menu with the 

Rollout option, or from the Hint/Annotation window. However, it is suggested you do it from 
the Hint/Annotation window as only there can you export the results to the clipboard using 
the Copy button. In both cases, the same options window is used as its reference. To use the 
rollout function you must first select the moves you want to rollout, otherwise the button will 
remain grayed out and inaccessible. You will want to set your preferred options the first time 
by clicking on the […] button to the right of the Rollout button.  
 

 
 
GNU offers a vast number of ways to set the rollouts, allowing you as many 

possibilities for efficiency as possible. Its 0-ply play is incredibly strong and practically instant, 
so it can help give meaningful results very quickly. GNU also plays according to score in its 
rollouts (using the match equity table of your choice naturally), which Snowie 4 does not for 
example. I will explain the main options, share the results of some of the testing that has 
been done, and share my preferences. 

 
When one opens the rollout options window for the first time, it can look vastly 

intimidating and confusing.  



 
 
However, it really isn’t, so let’s run through it from top to bottom and see what GNU 

can do for you. 
 
Trials 
 
The topmost part under the tab General Settings is where you set the number of trials. 

 

 
 

 The number of trials is simply the number of games you want GNU to play out (or roll 
out) as it collects the results. The more trials the better as this reduces the error margin of 
the results. After all, if it won a certain position 2 times in 3, it could be a fluke, but after 
hundreds or thousands of trials with variance reduction (see below) the results become far 
more trustworthy. 



 
 Playing strength 
 
 To set the primary playing strength used in the rollouts, click on the tab First Play Both 
at the top: 
 

 
 
 This is where you configure the primary strength of play. If you want to set a different 
playing strength for the cube decisions, you must go to the General Settings tab and at the 
bottom deactivate the option Cube decisions use same settings as Chequer play. 
 
 Evaluation for later plies 
 

One can set GNU to use a different playing strength after a specified number of plies 
in the Evaluation for later plies. 
 

 
 

 For example, suppose you had a backgame situation to rollout. Although you wanted 
the game to be rolled out at 0-ply (1900-2000 Elo), you didn’t trust the first plies to be the 
best. Enabling this as above, you could set the first 5 plies to be played at Supremo (2-ply) 
and the rest of the game at 0-ply, giving you a bit of both worlds. In fact this has been tested 
and shown to be very efficient for exactly that scenario. 
 
 So how does one set the playing strength of the first 5 plies (for example) and after? 
At the top, there are those mysterious tabs:  
 

 
 
If you click on the tab First Play Both, you can set the strength of the first plies to be 

played. Naturally, if you haven’t activated the Evaluation for later plies option this will be the 
default rollout playing strength. Now, once you have set this, click on the Later Play Both, 
and you will be able to set the playing strength for the subsequent plies. You can use this 
option in both full rollouts and truncated rollouts.  

 
Stop at specific Standard Deviation 
 
Obviously, a rollout with too few trials will not yield reliable results due to the large 

Standard Deviation, or in other words how much the result could be wrong by. The more 
trials the smaller the possible error, however how many trials are necessary? Unfortunately, 
this can vary a lot according to the position, so to get a Standard Deviation of 0.020 
(meaning the equity given could be actually 0.020 more or 0.020 less) one position might 



need 400 trials, and another might need 1400. This option is designed to address this 
problem. 
 

 
 
In the figure above, the margin was set to 0.100 and a minimum of 144 games were 

requested.  
 
Truncated rollouts 
 
Truncated rollouts are rollouts played to a certain number of moves as opposed to full 

rollouts. You may feel that the program doesn’t really need to play the game to the last move 
to know whether a move leads to good positions on average or bad ones. 
 

 
 
In the above figure the setting is 11 plies, so GNU will play out 11 moves, stop and 

evaluate the resulting position, and then start the next trial. This is far faster of course, and is 
particularly desirable if you want to analyze using a 2-ply playing strength which might be too 
slow for a full rollout. 

 
Cubeful 
 
This option is designed to activate or not cubeful rollouts.  

 
 

 
A cubeful rollout means that it is using the cube in the rollout and, just as in a normal 

game, might stop the rollout short due to a doubled cube that is passed. 
 
Bearoff Truncation 
 
Since GNU comes with bearoff databases allowing not only perfect play but perfect 

evaluations of a position as well, it makes since to have the program stop a rollout when it 
reaches one of these databases. 

 

 
 
Here one can activate or de-activate this option. It is on by default. 



 
 

Variance Reduction 
 

Whenever running a rollout, you will always want the Variance 
Reduction activated as it greatly increases the reliability of the 
results. The first time this ingenious technique was introduced to 
backgammon rollouts was by Fredrik Dahl, the author of Jellyfish. 
In a nutshell, it factors in luck when evaluating results, so that the 
program doesn’t need 10,000 games to average out the luck of the 
dice and that way be sure luck wasn’t a factor in the results 
obtained. With it, 100 rolled out games with Variance Reduction 
can be the equivalent of 5,000 games with no Variance Reduction. 

 
 Quasi-Random dice 
 
 Normally, GNU will roll the dice out completely randomly, but this may not be 
desirable in the rollouts. The reason is that luck may cause a number of flukes to happen, 
especially in the first roll. What if in your trials, the first roll it played never included some 
numbers which might lead to a slight change in its evaluation? The variance reduction will 
compensate for this, but so does the option to use quasi-random dice. 
 

 
 
This option deliberately alternates the first roll for every trial so that every possible first 

roll will have been played after 36 trials, starting with 1 and 1, then 1 and 2, all the way to 6 
and 6. The idea is to help negate the luck in the rollouts a bit more. However, this also 
means that if used, one must use a number of trials that is a multiple of 36. That is why 1296 
trials (or 2592 or 3888) is a good number to run rollouts as it is 36 x 36. 

 
Rollout as initial position 
 
If you plan to do a rollout on one of the opening moves you will want to activate the 

option Rollout as initial position. 
 

 
 
 The reason is that in the opening move one is not allowed to roll a double. This 
guarantees this will be respected if you roll from the opening position. 
 
 Seed 
 
 The seed is a random number that you can choose and that is linked to the random 
dice generator. It doesn’t affect the randomness by any means, and its sole purpose is to 
allow you or others to exactly reproduce rollout results.  
 

 
 

http://www.rci.rutgers.edu/~drhoover/SIMULATIONR.PDF


 If you see a posted rollout result with the played settings (strength and number of 
trials), the type of random dice generator chosen, and the seed, you should be able to 
exactly reproduce the results by using the same settings and the same seed. 
 
 Same cube and checker settings  

 
You may want to use different settings for the cube decisions than the checker play. If 

so, uncheck the option Cube decisions use same settings as Chequer play. 
 

 
 
 Same settings for both players 
 
 Although the obvious choice (and the default one) is to have both players use the 
same settings, you can also choose not to. 
 

 
 
 By deactivating the Use same settings for both players option, you can configure 
different checker and cube play settings for each side. Thus one side could be playing at 
Expert level, and the other at Supremo. To set the different playing strengths, you’ll now 
make use of two other tabs at the top: 
 

 
 
 Once you have opted for individual settings for each side, you must set them. Without 
this option, the tabs First Play Both and Later Play Both establish the playing strength for 
both sides. With it, they only determine the playing strength of the first player. You must go to 
First Play (1) to set the level to be used for the other player. If you have activated Evaluation 
for later plies you must also set the Later Play (1). 
 
 Final truncated evaluation 
 
 If you are using a truncated rollout, you may be concerned about the final and decisive 
evaluation. For example, you might be content to let it play 17 plies at 0-ply to evaluate the 
resulting position, but want a little more precision on the evaluation of the final position. You 
can change this by deactivating the Use player0 setting for truncation point. 
 

 
 
 When deactivated, you can set a different playing level for that final evaluation. It goes 
without saying that this is pointless for a full rollout. To set the level, you’ll need to go to the 
top to the Truncation Point tab. 
 

 
 
  



My suggested settings 
 
 A lot of testing has been done by a number of people seeking to find the most reliable 
settings under different circumstances, as well as spotting the unreliable ones. I’d like to
especially thank Michael Depreli, Ian Shaw, Ian Dunstan and Neil Kazaross for their 
painstaking research and the huge amount of computer time spent gathering and processing 
the data. The results helped answer a number of questions that reflect in my choice settings. 
 
 The first is that the 0-ply checker play is indeed extremely strong (as any victim of 
GGRaccoon can attest to) and due to its speed is usually ideal for full rollouts. It is only less 
than ideal for backgame situations where it may fail to make the most of the possibilities. So 
for pretty much any other situation, it can be used confidently. There has been significant 
questioning of the odd-ply play as it has often been seen that 1-ply would produce erratic 
results. Tests have shown that this is true of cube decision, but 1-ply checker play is a bit 
stronger than 0-ply as one would expect. 
 
 The next issue is the one of speed. It is possible to significantly speed the play up of 
the higher 2-ply levels by enabling the reduced evaluations. The question therefore is how 
much this affects the results. Tests have show that the checker play is seriously affected by 
this and the deeper the reduction the more errors tend to appear. Consequently it is highly 
suggested that no speed reduction be used for checker play. On the other hand, the quality 
of the cube decisions was affected very little, and very reliable results were shown using 25% 
speed (a 4x speed-up) for cube decisions. 
 
 The primary setting is what I use the most and covers 95% of my rollouts, giving 
excellent results within a few minutes. 
 
• My primary setting:  

o Set the number of games to either 648 games or 1296 using the arrows on the 
right. The reason for these numbers is that there are 36 possible combinations of 
the dice, and 1296 is 36 times 36. 

o Uncheck Truncate Rollouts, meaning it is a full rollout. 
o Set the level to Expert 
o Leave the other defaults 

 
• My secondary setting is when I feel the cube decisions at 0-ply may not be reliable: 

o Set the number of games to either 648 games or 1296 using the arrows on the 
right. The reason for these numbers is that there are 36 possible combinations of 
the dice, and 1296 is 36 times 36. 

o Uncheck Truncate Rollouts, meaning it is a full rollout. 
o Uncheck Cube decisions use same settings as Chequer play 
o Set the chequer play at Expert,  
o Set the Cube decisions at World Class with reduced evaluations at 33% 
o Leave the other defaults 

 
• My third setting is when the first moves may be difficult (backgame, etc.) 

o Set the number of games to either 648 games or 1296 using the arrows on the 
right. The reason for these numbers is that there are 36 possible combinations of 
the dice, and 1296 is 36 times 36. 

o Activate Enable separate evaluations and set Change eval after ply to 6. 



o Uncheck Truncate Rollouts, meaning it is a full rollout. 
o Under the tab First Play Both set the chequer play at World Class 
o Under the tab Later Play Both set the checker play to Expert. 
o Set the Cube decisions at World Class with reduced evaluations at 33% 
o Leave the other defaults  

 
Copy and Paste results 

 
Once you have set your choices, press Ok, and then the Rollout button. When you are 

done, you may wish to copy the results to a document or e-mail for example. To do so, just 
click on the moves that interest you, and then press the Copy button as shown. 
 

 
 
 To see the results, just paste them on the document (Ctrl-V for Windows users).  
 
1. Rollout          24/15                        Eq.:  +0.177 
59.4%  18.0%   0.7% -  40.6%   8.8%   0.4% CL  +0.177 CF  +0.177 
[0.3%   0.4%   0.1% -   0.3%   0.2%   0.0% CL   0.006 CF  +0.006] 
Truncated cubeful rollout (depth 19) with var.redn. 
648 games, seed 1193803392 using Mersenne Twister 
Play and cube: 0-ply cubeful [expert] 
2. Rollout          13/10* 13/7                  Eq.:  +0.062 ( -0.115) 
53.6%  27.0%   1.4% -  46.4%   8.8%   0.3% CL  +0.062 CF  +0.062 
[0.3%   0.4%   0.1% -   0.3%   0.2%   0.0% CL   0.007 CF  +0.007] 
Truncated cubeful rollout (depth 19) with var.redn. 
648 games, seed 1193803392 using Mersenne Twister 
Play and cube: 0-ply cubeful [expert] 
 

If you are using Word or Wordpad, it is suggested you set the pasted text to the font 
Courier New, and the size to 9 or 10, else the formatting will be lost, and it may be difficult to 
read. 

 
Once more: Remember to save your settings before exiting the program or you will 

need to reconfigure your settings the next time you use GNU. 
 
Setting up a position 
 
Naturally, other than matches and games, you might just want to set up a position 

from a book or other source, and ask GNU’s expert advice. First, you must start a new game 
or match, and then just press the Edit button, located at the top in the toolbar. 

 

 
 



Names and score 
 
At the bottom, you will see you have the option of setting the scores or the names of 

the players. 
 
Side, cube, and dice 
 
If you want to change the dice on the board, click on the side of the board where you 

would normally click to roll the dice. If you click on the left-side of the board it will propose the 
dice for the top player, and if you click on the right-side of the board it will present the dice for 
the bottom player.  
 

You can set whose turn it is to play by clicking on the small chequer next to the 
player's name at the bottom.  
 

 
 

You can also set the turn of the player to move in the Game menu and by selecting 
Set turn at the bottom. 

 
To set the cube position and value click on the cube or enter the Game menu and 

select Set cube. A small window will appear with cubes set in all directions.  
 

 
 
The cubes that are upside down are for the top player, the ones rightside up are for 

the bottom player, and if you wish to set the cube in the center, choose the ones facing 
sideward. If you want the cube at its initial value in the center, choose the 64 cube facing 
sideward. 

 
*Tip* - If you want to setup the same position another GNU user posted, you don’t 
need to set it all up manually. You can simply copy the Position ID and Match ID and 
instantly get the same position, cube, and score. Suppose you saw this: 

 



GNU Backgammon  Position ID: sGfwGQDg28EBBg 
Match ID   : cAlvATAAIAAA 
+13-14-15-16-17-18------19-20-21-22-23-24-+     O: Kit Woolsey 
| X           O    |   | O  O  X          |     3 points 
| X           O    |   | O  O  X          | 
| X                |   | O                | 
|                  |   | O                | 
|                  |   |                  | 
|                  |BAR|                  |     11 point match (Cube: 1) 
| O                |   | X                | 
| O                |   | X                | 
| O           X    |   | X                | 
| O     O     X  X |   | X                |     Rolled 63 
| O     O     X  X |   | X                |     4 points 
+12-11-10--9--8--7-------6--5--4--3--2--1-+     X: Gammonline Readers 

 

Just copy the code after the Position ID into your GNU’s space (highlight it and press 
Ctrl-C) for the Position ID 

 

 
 

Then press Enter. Now do the same for the Match ID, and that’s all there is to it. 
 
Checker setup 
 
Moving and setting up the checkers is quite easy and Snowie users will feel at home 

as the method is identical. To remove or add white checkers to a point for example, use the 
right mouse button and click on the point. You determine the number of checkers to be 
added or removed by the height of the point you press. For example, in the following diagram   
 

 
 



if you have 5 white checkers on the 19-point and only want to have 3, click with the right 
mouse button on the 3rd checker where the yellow arrow indicates and the top two will be 
removed. Adding checkers is the same, so if you wanted to add a red checker to the 6-point 
you would place the cursor where the green arrow indicates and left-click. If you want to 
quickly get the starting position, you can click on the area indicated by the blue ellipses on 
the left, and if you want to quickly clear the board of all checkers, click instead on the right 
side on the area indicated by the pink ellipses. Try it and experiment a little. It’s much easier 
to do than to explain. 

 
 
Once the position is set up, press the Edit button again to exit Edit mode. Now just go 

to the Analyse menu and select Hint (suggested even for rollouts). Attention, this isn’t a 
suggestion, you must exit the Edit mode before asking for GNU to evaluate the position 
otherwise you will get odd results. 
 
 

Appearance 
 
Skins 
 
You can change the overall appearance of the menus through a number of skins 

included with the installation, however this cannot be done from within the program and must 
done manually. The procedure is fairly painless if you aren’t afraid of moving a couple of files 
in the Windows Explorer.  

 
Open Windows Explorer, and enter the \Program Files\gnubg directory. In it there is a 

directory called \Themes, where the skins are located, and in that, you will see a number of 
directories with the names of the skins they contain. Enter the directory you want and copy 
the files in it to the main \gnubg directory. It will ask you if you want to overwrite the files in it. 
Say yes, and start GNU to see the changes. It is important to copy and not move the files, so 
if you’re not Windows savvy, this means holding the Ctrl key on the keyboard down while 
dragging the files. Keep the Ctrl key pressed when you let go of the mouse button. My 
favorite is the one called ‘mac’, and is what you see throughout this article. 
 

Boards 
 
The appearance of the boards can also be changed making use of a number of 

presets, or you can design your own. To make changes, go to the Settings menu and select 
Appearance. A window will appear, displaying a number of tabs at the top. Select Designs 
and you will see a list of the preset board designs, as well as thumbnails of what they look 
like. To choose one, just click on the name of the preset and press Ok. That’s all there is to it. 

 



 
 
You can also make your own designs and save them. Using the tabs at the top, you 

can change the appearance of the board and if you really like your new design, go back to 
the Designs tab and save it by pressing Add current design and then Save designs. Send the 
GNU team your best ones, and they may include them in the next release, which is just 
about everyday by the way.   
 
 

Conclusion 
 
By now it should be clear that while a number of backgammon players have 

complained about the steep prices of top commercial software excluding them from the tools 
and type of progress available to more fortunate players, that complaint is now definitely 
without foundation.  

It’s true that it is ever a work in progress and has its rough edges, but with time they 
will undoubtedly be ironed out for the most part. It is also an engine that is stronger than its 
older top-of-the-line siblings in GamesGrid, and at its price (free), one would have to be crazy 
not to have it, even if one does own the legendary Snowie. After all, two heads are better 
than one.  

I would like to effusively thank the authors of GNU Backgammon and its numerous 
contributors, and would also like to suggest that anyone enjoying their efforts make a 
contribution to the Free Software Foundation (FSF), the principal organizational sponsor of 
the GNU Project, as a token of appreciation. The FSF survives mostly off the contributions, 

http://www.fsf.org/


however small, of private donations, and without it, those loud complaints mentioned above 
would be entirely justified.  

 
A Word about ‘Cheating’ 
 
By far, the most common complaint seen about all backgammon software, weak or 

strong, is that it must be cheating to get so lucky. Most of these complaints stem from a lack 
of understanding of probabilities, and how skillful play will affect luck or the possibility of lucky 
rolls.  

To begin with, let it be stated that there is no bias of any kind, and the source code of 
GNU is open to any doubting it. If you still cannot believe it, feel free to use your own dice by 
entering the Settings menu and selecting Options, and then in the right side Manual dice. If 
you are rigorously honest about your results, you will find no difference in the long run. 

Probabilities are what rule supreme in backgammon. As there is indeed an 
uncontrollable luck factor, one cannot guarantee a victory or loss no matter how stacked up 
the chances are. So, good backgammon strategy is designed to maximize the good rolls for 
the playing side, and minimize the good rolls for the other side. In other words, after the best 
play, there will be less good rolls for the other side. If the other side doesn’t realize what is 
happening, then it will seem like a never-ending streak of bad luck. It’s not; it’s the 
consequence of good playing. GNU is among the very best, so use it and learn with it. You 
can set it at a much weaker setting, and watch how its luck dries up. 

The mathematics behind probabilities are also usually very poorly understood. Take 
for example the situation below. If your opponent had a checker on the bar, what is his 
chance of entering that single point? 
 

 
 

 If you said 11 chances in 36 or a little over 30%, good for you, but if you said 1 in 6 
then you need a little brushing up. 1 in 6 would be correct if your opponent were only using 
one die, but with two, the chances add up to 11 in 36. So how come you never enter and 
GNU does? It may seem like that at times, but it’s really not the case. It is natural to focus 
more on what causes us anguish making reality look quite distorted, but maybe you were 
very unlucky. Stories of hard luck abound. In a live game, I once played my opening move, 
and then lost to a backgammon without ever playing another move. My opponent hit me, and 
I danced for the rest of the game. I wasn’t even able to avoid a backgammon. A top 
professional once told me of an instance where he was giving a gammon, got hit, and lost 
after dancing 7 straight times against a 3-point board. Does it seem to get more doubles? 
What about those doubles you rolled while on the bar? They don’t count, you say? Sorry, but 
lady luck makes no case of guaranteeing the double will arrive at the right time. Good 
strategy will help you be able to use it when it does arrive. 
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